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INTRODUCTION

M icrosoft Office 2016 is by far the most popular suite of productivity
applications in the world, and with good reason. Its applications are
powerful enough for business and professional use, and yet easy enough that
a beginner can catch on to the basics with just a few simple lessons.

If you're new to Office 2016, this book can help you separate the essential
features you need from the obscure and more sophisticated ones that you
don't. For the four major Office applications I cover in this book — Word,
Excel, Outlook, and PowerPoint — I walk you through the most important
and common features, showing you how to put them to work to make it easier
to do your job.

I designed this book for time-pressed Office users who simply want to figure
out the task at hand without spending a lot of time looking for answers. This
full-color book presents the most common Office tasks in illustrated, step-
by-step instructions and organizes them so that they're easy to find, read,
and apply. It covers classic Office tasks such as typing and formatting text,
calculating with spreadsheets, organizing email and to-do lists, and creating
PowerPoint presentations.

About This Book

This book is organized into chapters, each split into a series of common tasks.
It begins by familiarizing you with Office 2016 and showing you how to
perform basic tasks such as starting and exiting each application, entering text,
moving around, and saving your work. Then it covers each of the four main
applications:

Word (Chapters 2-6): A word processing application, suitable for creating
reports, newsletters, manuscripts, memos, and mail merges.

Excel (Chapters 7-11): A spreadsheet application, great for storing data lists,
calculating columns of numbers, and creating graphical charts that summarize
numeric data.

Outlook (Chapters 12-13): An email and personal information management
application you can use to send and receive mail, manage an address book,
and track your daily to-do list.

PowerPoint (Chapters 14-17): A presentation graphics application for build-
ing and delivering attractive presentations that include graphics, animations,
and even sound and video.

You can read the chapters in any order, at any time. Although each task is
explained step by step, if you have trouble with a particular task, I recommend



reading the entire chapter for that task — it’s just possible that you'll find a
different, better approach to accomplishing the task.

Foolish Assumptions

This book assumes that you can start your computer and
use the keyboard and mouse (or whatever device moves the
pointer onscreen).

Office 2016 runs on Windows 10 (the newest version of
Windows), Windows 8, and Windows 7 computer operating
systems, so I assume you're using one of these. The examples
in this book show Office 2016 running in Windows 10, but
Office works mostly the same on all operating systems. If
you are using Office applications on some other platform,
like Linux, Mac, or a tablet or smart phone, things may not
look or work exactly the same as described in this book.

Icons Used in This Book

The following icons highlight important or useful informa-

W tion in this book.
Tips can save you time or make it easier to do something.
SMBER
This icon emphasizes useful information to keep in mind
when using Office.
@‘“‘NG! Watch out! This icon alerts you about something that can
S hurt or wipe out important data. Read this information
before making a mistake that you may not be able to recover
from.
Beyond the Book

www . dummies . com has a heaping handful of additional
Office information:

® You can find a cheat sheet with shortcuts for working in
Office 2016 at www.dummies.com/cheatsheet/
office20l6atwork.

® Visit www . dummies . com/go/dummiesvideo to access the
Office 2016 For Dummies online video course, featuring 150
how-to videos on Office 2016.


http://www.dummies.com/
http://www.dummies.com/cheatsheet/office2016atwork
http://www.dummies.com/cheatsheet/office2016atwork
C:/Users/shayes/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/RLMAOWIS/www.dummies.com/go/dummiesvideo
http://www.dummies.com/go/dummiesvideo

To gain access to the online video, all you have to do is regis-
ter. Just follow these simple steps:

© rind your PIN code.

e Print book: If you purchased a hard copy of this
book, turn to the inside back cover of this book to
find your PIN.

¢ E-book: If you purchased this book as an e-book,
you can get your PIN by registering your e-book.
Go to www.dummies . com/go/dummiesvideo and
follow the instructions. You'll be asked to fill in
some registration information and answer a security
question to verify your purchase. Once you handle
those steps, you'll receive an e-mail with your PIN.

e Go to www.dummies.com/go/dummiesvideo.

e Follow the onscreen instructions to create an
account, enter your PIN, and establish your own
login information.

Now you're ready to start watching your videos! Your PIN
gives you access to watch as often as you want for 12 months
after you register. Once you create your registration, simply
return to the video site and log on with the username and pass-
word you created. No need to enter your PIN a second time.

< If you have trouble with your PIN or can't find it, contact

Wiley Product Technical Support at 877-762-2974 or go to
http://support.wiley.com.

Where to Go from Here

This is your book; use it how you want. You can start at the
beginning and read it straight through, or you can hop to
whatever chapter or topic you want. For those of you who
are pretty new to computers, you might want to start at the
beginning. If you're new to Office, the beginning part will
give you a good foundation on what features work similarly
in all the programs.

If you're new to Office 2016, I recommend that you start by
reading Chapter 1, which introduces Office 2016 concepts
you may not be familiar with, and explains what all (or
most) of the Office apps have in common.


http://www.dummies.com/go/dummiesvideo
http://www.dummies.com/go/dummiesvideo
http://support.wiley.com




CHAPTERONE

Getting to
Know Office

icrosoft Office is a suite of applications.

A suite is a group of applications
designed to work together and that have
similar user interfaces in order to cut down
on the learning curve for each one. Office
2016 includes a word processor (Word), a
spreadsheet program (Excel), a presentation
graphics program (PowerPoint), and an
e-mail program (Outlook). Depending on
the version of Office, it may also include
other programs. Sweet, eh? Er . . . suite.

Because all the Office apps have similar
interfaces, many of the skills you pick up
while working with one program also trans-
late to the others. In this lesson, I introduce
you to the Office interface and show you
some things the programs have in common.
For the examples in this lesson, I mostly use
Word and Excel, because they are the most
popular of the applications. Keep in mind,
though, that the skills you learn here apply
to the other applications, too.

Throughout the book, the examples all
show Windows 10 as the operating system.
Where Windows 7 or 8 are substantially
different, I let you know what to expect.

In This Chapter

w= Starting and exiting an
Office application

= Using the Ribbon
u=Jsing the File menu
u=Creating a new document
m=Changing the view

= Saving your work

= Closing a file

m=>Qpening a saved file



Start and exit an Office application

\\3

There are several ways to start Office applications. For example,
you can select it from the Start menu’s All Apps list. (Hint: It's in
a folder called Microsoft Office 2016, so look in the “M” section.)
You can also use the Search feature: with the Start menu open,
begin typing the application’s name and then click its name when
it appears. Depending on how your PC is set up, you might also
have shortcuts to one or more of the Office apps on your desktop
or taskbar, or pinned to the top level of the Start menu.

You can also double-click a data file that’s associated with one of
the Office applications to start that application.

The following steps explain how to start an Office application in
Windows 10; if you are using earlier versions of Windows, check
out the Tips throughout this book that point out differences:

0 On the taskbar, click the Start button.

If the application you want to run appears at the top of
the Start menu, click it and you're done with these steps.

Faithe Wempen Life at a glance

ed

Word 2016

Outlook 2016 Calendar

PowerPoint 2016

Excel 2016 e

Snagit 12 Microsoft Edge  Photos Cortana

" Get Started

Weather Phone Compa.. OneNote

File Explorer Play and explore

@ Settings

" Power ';‘ @

£= Allapps New Xbox Groove Music

Ask me anything

Figure 1-1: Click Start and then click All Apps.
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© Click All Apps.

If you have Windows 8.1, the All Apps button is a down-
pointing arrow at the bottom of the Start screen. If you
have Windows 7, click All Programs instead of All Apps.

e Scroll down to the section for the first letter of the
application name. For example, to run Word, scroll down
to the W section.

In step 3, if you have Windows 8.1, the applications won't
be in the lettered sections because the alphabetical list

is only for modern apps, not desktop apps; scroll to the
right to find the Microsoft Office 2016 section. If you have
Windows 7, all the folders and shortcuts are arranged in a
single alphabetical list, so it should be fairly easy to find
Microsoft Office 2016.

e Click the desired application.

Weather

Windows Accessories

Windows Feedback

Windows Media Player

Windows PowerShell

v

w
R
R
R
I
O]
R
R

Windows System

=
uw

Word 2016 < 4

X

"_\ Xbox

é Back

Windows Administrative... -

Windows Ease of Access

Life at a glance

Calendar

(S

Microsoft Edge

3

Weather Phone Compa...

Play and explore

»n ©

Xbox Groove Music

g [

OneNote

S

Movies & TV

Figure 1-2: Scroll to the W section and click the desired

application.

5. Press the Esc key to bypass the Start screen that appears.

In Word, Excel, and PowerPoint, a Start screen appears
when you run the application from which you can select
a template for a new document or open an existing

document.



e Click the Close (X) button in the application window’s
upper-right corner to close the application.

< If you have any unsaved changes, you are prompted to

save them here. See “Save your work” later in this chapter
for more information about saving.

= u) ¢

Figure 1-3: The Close button shuts
down an application.

Now let’s try opening and closing again, this time using a
different method for both.

e Click in the Search box on the taskbar.

Figure 1-4: Click in the Search box.

(8 ) Begin typing the name of the application to open (for
example, type Excel).

e In the search results that appear, find the name of the
application you're typing, then click that name. The
application opens.

Best match 0

X Excel 2016
Desktop app

Store
[T Excel Mobile

Spreadsheet Editor - Edit Excel & CSV Files
Folders

excel - in Tools

excel - in Tools

excel - in Tools

excel - in Tools

R My stuff L web

E}(cel

Figure 1-5: Search for the application’s
name and then click it in the search results.



10. Press Alt+F4 close the application.

Now that you know how to start and exit Office applications,
let's take a look at the interface of a typical Office application.

Work with the Ribbon

All Office applications have a common system of navigation
called the Ribbon, which is a tabbed bar across the top of the
application window. Each tab is like a page of buttons. You click
different tabs to access different sets of buttons and features. To
explore the Ribbon, follow these steps:

1. Open an Office application, as discussed in the previous
section, and if needed press Esc to bypass the Start screen.

9 On the Ribbon, click the desired tab.

3. Click the desired command.

Document1 - Word sl a

H.,meﬂ Design  layout References  Mailings  Review  View Q) Tell me what you want i Fd\lhe\f\/mn:.}url

. LOind -
AaBbCeDd| AsBbCeDd AgBhCc AzsBbCcl AaB N

T Normal | TNoSpac.. Heading1 Heading 2 Title

Calibri Body)~ |11 *| A A |Aa~x B i=riz«lic~
3, Replace
Paste B I U-aex x A-¥-A-=

¥ Format Painter 7| Iy select~

Clipboard & Font Styles 5 Ediing A~

Here are some key facts to know about Ribbon commands:

0 Not all commands are available all the time. For example,
you can’t paste content until you first cut or copy it.
Commands that appear gray (dimmed) are currently
unavailable.

e Buttons are organized into groups. The group names
appear at the bottom.

e Some groups have dialog box launchers; these open a
dialog box or task pane relating to the commands in that
group. The one in the Font group, for example, opens the
Font dialog box.

Q Some buttons, such as Bold or Italic, are on/off toggles.
Each time you click the button, it switches its state from
one to the other.

e Some groups contain drop-down lists from which to
choose settings such as fonts or sizes.

e Some buttons work as a group from which only one
button can be selected at a time. One example is the four
buttons in the Paragraph group that control horizontal
alignment of paragraph text.
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@ Some buttons have a small arrow on them. In some cases,
if you click the button face (not the arrow), the current
setting is applied. If you click the arrow, on the other
hand, a menu opens for changing the current setting. In
other cases, clicking the arrow or the button face has the
same effect: opening a menu.

m Some groups, such as the Styles group, contain galleries
from which you can choose settings by graphical example.

© You can hide the Ribbon to save space by clicking the
Collapse the Ribbon arrow or pressing Ctrl+F1. When you
do so, the tab names remain onscreen; click a tab name
to reopen the Ribbon. Then click the Pin the Ribbon icon
(the tiny pushpin) at the far right end of the Ribbon to
re-pin it open.

Document! - Ward = o

Q Tellm \ want tc Faithe Wempen

OFind -
2L 1 aabbcedd. Aagbcedd AaBbCc AsBbcer AJ B

2, Replace
T Normal | TNoSpac.. Heading1 Heading 2 Title

Home  Insert  Del layout  References  Mailings  Review  View

Calibri Body; = |11 | A A Aav B i=-i

Paste
)

- con WA - B
Format Painier B g1 U 7ok X 3 A - = Iy selea~

Font Styles s Ediing -~

6 ¢°

Figure 1-7: Ribbon controls.

@

o Depending on the width of the application window, some
groups may appear collapsed. When a group is collapsed,
it appears as a single button with the group’s name. When
you click the button, a palette appears containing all the
group'’s individual commands.

d Eal - O >
pview  View Q Tell me.. Faithe Wempen
AaBbCcDd AaBbCeDd AQBbC( [~ P
T Normal | T No Spac... Heading 1 |+ (=dlifirg)
Styles [} ~
OFind ~
b _Replace
L& Select
Editing

Figure 1-8: When the application window is not
wide enough to display all the Ribbon content,
some groups appear collapsed.



Use the File menu

In each Office application, clicking the File tab opens the File
menu, also known as Backstage view. Backstage view provides
access to commands that have to do with the data file you're
working with — commands such as saving, opening, printing,
mailing, and checking the file’s properties. The File tab is a differ-
ent color in each application. In Excel, for example, it's green. To
explore Backstage view, follow these steps:

1. Click the File tab. Backstage view opens.

A\\J

e Click the desired page from the navigation pane at the left.

The pages are the same between applications. Table 1-1
summarizes them.

e If applicable, click a section. Not all pages have sections.
@ Click the desired command.

OR

@ Click the back arrow or press Esc to leave Backstage view
without making a selection.

Share

New

Share

Open

&%  share with Pecple
Email
) Present Online

[E Postiosiog
Account
Options

Feedback

Documenti - Werd

Email

U7 g
Send as
‘Attachment

T
day
Send as
PDF

|

T
)

Send as XPS

- a

Faithe Wempen

Everyone gets a copy Lo review

Everyone works on the same copy
Everyone sees the latest changes

Keeps the email size small
Document must be saved in a shared location
Everyone gets a PDF attachment

Preserves layout, formatting, fonts, and images
Content can't be easily changed

Everyone gets an XPS attachment
Preserves layout, formatting, fonts, and images
Content can't be easily changed

o fax machine needed

Figure 1-9: After clicking File, click a page and choose the command to issue.

11



Table 1-1

Pages on the File Menu in Word, Excel,
and PowerPoint

Page

What You Can Do

Info

See and edit file properties
Password-protect the file and restrict editing
Inspect the file for privacy, accessibility, and
compatibility

Recover unsaved versions

New

Start a new file using a template

Open

Open an existing file

Save

Save the active file for the first time, or save changes to
an existing file using the same settings

Save As

Save changes to an existing file using different
settings

Print

Print the active file

Share

Invite others to view or edit the file online
Send the file via email to others

Present online (Word and PowerPoint only)
Publish slides (PowerPoint only)

Post to blog (Word only)

Export

Create a PDF or XPS version

Change the file type

Create a video (PowerPoint only)

Package a presentation for CD (PowerPoint only)
Create handouts (PowerPoint only)

Account

View and change the active Microsoft account

Change the background and theme for the application
window

Connect to online services (OneDrive, YouTube,
Facebook)

Manage updates and subscriptions

Options

Control application settings

Close

Close the active document

12



Create a new document

When you start an application, a Start screen appears. From
there, you can choose a template on which to base a new doc-
ument. (I'm using document generically here to refer to a Word
document, Excel workbook, or PowerPoint presentation file.) If
you just want a blank file with default settings, press Esc to start
one without having to choose a template. (Choosing the Blank
template is the same as pressing Esc.)

You can also create additional new files without exiting and
restarting the application. If you want an additional blank file
with default settings, the easiest way is to press Ctrl+N. If you
want a new file based on a template, follow these steps:

0 Click the File tab, and click New. A gallery of templates
appears.

A Type a keyword in the Search for online templates box
and press Enter.

OR
@ Click any template you want, then skip to step 4.

Document1 - Word - ja

faithe Wempen

New

Search for online templates @ p

Suggested searches: Business Personal Industry Print Design Sets Education  Event

FEATURED  PERSONAL

6 Title a Aa @

Take a
tour

Blank document Welcome to Word Blog post Single spaced (bla...

Feedback

Title Title Title
icading Heading 2 romomns

Figure 1-10: Select a template thumbnail, or type a keyword to search for templates.
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9 In the search results, click the desired template to see
details about it.

Document1 - Word H - a bes

Faithe Wempen

New
3 Home | report p
* Category -
Business 127
Reports 97
Industry 62
Small Business 9
Education 45
Finance - Accounting 35
Report (Essential... School book report Annual report wit. Pressntations 34
Account Logs 32
Student 32
epme =r Projects 28
Feedback e Teacher prd
iy Orientation 26
Personal %
Database 25
- Report Sections 25
Project status rep. Student report wi... Project status rep... ~ Blue 24 -

Figure 1-11: Choose a template from the search results.

e Click Create to download the template and start a new file
based on it.

Annual report with
cover photo (Timeless..

Provided by: Microsoft Corporation

Use this template to create an Annual Report for
your company. Includes how-to information as well
as pre-formatted titles for traditional Annual Report
sections. Select a different cover from the Insert tab
REPORT on the ribbon. Change the colors by selecting
P [VEAR] different built-in themes. Find matching templates

in the Timeless design set by clicking the See Also
link above.

4 Morelmages P )
Download size: 1141 KB

10

Create

Figure 1-12: Choose a template from the search results.

Depending on the template you choose, the document might
not behave exactly like a blank document would. There might be
pre-entered content, special formatting, or text placeholders. You
are not locked into any of the content or formatting that comes
with a template. You can delete any content that you don't want,
and make any changes as desired.
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Enter text

Because of the layout differences among Excel, Word, and
PowerPoint, the process of entering text in each program differs.

Word

Word places text directly on the document page (unless you
happen to be using a template that employs text boxes, which is
common for complicated layouts like newsletters). To type text
in a Word document, just start typing. The insertion point

(a flashing vertical line) shows where the text you type will
appear. (See Figure 1-13.)

Press Enter to start a new paragraph. (You don’t have to press
Enter at the end of each line, because Word wraps text to the next
line automatically as needed.)

To edit text, press Backspace to erase the character to the left of
the insertion point or Delete to erase the character to its right.
You can also select text (see “Select text” in Chapter 2) and then
press either of those keys to delete the selection or type new text
to replace the selection.

B - 0 .
Home | Insert

.

Paste

 Format Painter

clipboard

Document! - Word m a
Design layout References  Mailings  Review  View @ Tell me whal you want to Faithe Wempen
Body) - K K Aae A ISeiT.ut. @2 AL q s ne Lrind -
Calibri Boay -[11_+| X £ | Aa 1= == 4 naBbceod AsBbeend AgBbCc Aaebcel AJB - 4 fepiace
B I U -sx.x A-¥-A-==== 1=- H-ii- 1T Normal | TNoSpac.. Heading1 Heading 2 Title:

= Ly Select-
Font & Paragraph 3 Styles w Ediing ~

The annual revenues for the North region are well within the projected estimetes.—l

Insertion point

Figure 1-13: Type text directly onto the document page in Word.

Excel

Excel stores text in cells, which are boxes at the intersections of
rows and columns. To type text in an Excel cell, click the desired
cell to make that cell active, and then type.

15



3

It's okay if the text is so long that it doesn't fit in the cell. The

text can spill over into cells to the right if they are empty. In
Chapter 7 you will learn how to format an Excel worksheet to

correct cell width problems.

When you are finished typing in that cell, click a different cell,
or press an arrow key on the keyboard to move one cell in the
direction of the arrow, or press Enter to move to the cell below

the active one.

If you need to edit the text in a cell, double-click the cell to
move the insertion point into it, or click the cell to select it and
then make your edits in the formula bar, which lies between the
Ribbon and the column headings. (See Figure 1-14.)

Formula bar

B ©- L I Book - Excel
Home | Insert  Pagelayout Fornulas Data  Review  View Q' e what yo

% -
Calibri o L)

B IU- A -

| Revenus
4
5

m a
Faithe Wempen
sy O

Find &

[ Formar- & Select*

Figure 1-14: Type text and numbers into cells in Excel.
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Insertion point

PowerPoint

PowerPoint places text in movable, resizable boxes on slides.
Different slide layouts come with different placeholder boxes,
and you can change layouts if you want a slide to have different
placeholders. You can create your own text boxes, but you can’t
type text directly onto the slide. Everything has to be in some
sort of box or frame. To place text in a placeholder, click inside
it and start typing. At that point, text editing is the same as in

Word. (See Figure 1-15.)




